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front matter


  
preface


  
Is C programming still relevant?


  Every time I read that C is becoming obsolete, another article pops up on how C continues to be one of the most popular, in-demand programming languages—even as it passes its 50th birthday. Disparagement aside, C is the primary language used for system programming, networking, gaming, and coding microcontrollers. Even those trendy languages that the cool kids boast about most likely have their core originally written in C. It’s not going away any time soon.


  I often refer to C as the Latin of computer programming languages. Its syntax and even a few keywords are borrowed heavily by other languages. Just as knowing Latin helps you understand and learn French, Italian, Spanish, and other languages, knowing C allows you to easily understand and learn other programming languages. But don’t stop there! Honing your C skills is just as important as exercising a muscle. And what better way to work on and perfect your C programming abilities than to continually write small, useful programs?


  
Why did I write this book?


  I feel the best way to learn programming is to use small demonstration programs. Each one focuses on a specific part of the language. The code is short and easy to type, and it drives home a point. If the little program can do something impressive, inspiring, or silly, all the better.


  My approach contrasts with other programming books I’ve read. These tedious tomes often list a single, huge program that drives home all the concepts. Typing 100 lines of code when you have no clue what’s going on is discouraging, and it misses one of the more delightful aspects of programming: instant feedback.


  Somehow, the habit of writing tiny programs sticks with me, even beyond when I’m writing a C programming book or teaching an online C programming course. For years, I’ve been coding tiny programs on my blog at https://c-for-dummies.com/blog. I do so to provide supplemental material for my readers and learners, but also because I enjoy coding.


  Of course, to make small programs meaningful, they must dwell in the ancient command-line, text-mode environment. Graphics are limited. Animation is dull. The excitement, however, remains—especially when something useful is presented all within only a few lines of code.


  My approach echoes the way I code: start small and grow the code. So, the programs in this book may begin as only a dozen lines of code that output a simple message. From there the process expands. Eventually a useful program emerges, all while remaining tiny and tight and teaching something useful along the way.


  Who knows when the mood will hit you and you decide to code a handy command-line utility to improve your workflow? With a knowledge of C programming, the desire, and a few hours of your time, you can make it happen. It’s my hope that this book provides you with ample inspiration.
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about this book


  
Who should read this book?


  This book assumes that you have a good knowledge of C. You don’t need to be an expert, but a raw beginner may struggle with the pace. Though I explain the techniques used and my approach for writing these small programs, I don’t go into detail regarding how the basic aspects of C work.


  The operating system I chose is Linux. Though I’ve run the code on a Linux box, I developed the programs on Ubuntu Linux running under Windows 10/11. The programs also run on a Macintosh. All the programs in this book are text mode, which requires a terminal window and knowledge of various shell commands, though nothing too technical or specific. Chapter 1 covers the details of coding and building in the command-prompt environment.


  Bottom line: this book was written for anyone who loves the C language, enjoys programming, and takes pleasure from writing small, useful, and interesting programs.


  
How this book is organized: A road map


  This book is organized into 15 chapters. The first chapter touches upon configuration and setup to ensure that you get started properly and are able to code and create the programs without going nuts.


  Chapters 2 through 15 each cover a specific type of program. The chapter builds upon the program’s idea, often presenting a simple version and then expanding the program to offer more features. Sometimes other programs are introduced along the way, each of which follows the main theme or otherwise assists the primary program in its goal.


  
Software/hardware requirements


  Any modern version of a C compiler works with this book. The code doesn’t touch upon any of the newer C language keywords. Some functions are specific to the GNU compiler. These are mentioned in the text, with alternative approaches available if your C compiler lacks the GNU extensions.


  No third-party libraries are required to build any of the programs. Variations in Linux distributions or between Windows 10/11 and macOS play no significant role in creating the code presented here.


  
Online resources


  My personal C programming website is c-for-dummies.com, which is updated weekly. I’ve been keeping up my habit of weekly C language lessons since 2013, each one covering a specific topic in C programming, offering advice on coding techniques, and providing a monthly Exercise challenge. Please check out the blog for up-to-date information and feedback on C, as well as more details about this book.


  I also teach various C programming courses at LinkedIn Learning. These courses range from beginner level to advanced topics such as using various C language libraries, pointers, and network programming. Visit www.linkedin.com/learning/instructors/dan-gookin to check out my courses.


  
About the code


  This book contains many examples of source code both in numbered listings and in line with normal text. In both cases, source code is formatted in a fixed-width font like this to separate it from ordinary text.


  In many cases, the original source code has been reformatted; we’ve added line breaks and reworked indentation to accommodate the available page space in the book. In rare cases, even this was not enough, and listings include line-continuation markers (➥). Additionally, comments in the source code have often been removed from the listings when the code is described in the text. Code annotations accompany many of the listings, highlighting important concepts.


  You can get executable snippets of code from the liveBook (online) version of this book at https://livebook.manning.com/book/tiny-c-projects. The complete code for the examples in the book is available for download from the Manning website at www.manning.com and from GitHub at github.com/dangookin/Tiny_C_Projects.


  
liveBook discussion forum


  Purchase of Tiny C Projects includes free access to liveBook, Manning’s online reading platform. Using liveBook’s exclusive discussion features, you can attach comments to the book globally or to specific sections or paragraphs. It’s a snap to make notes for yourself, ask and answer technical questions, and receive help from the author and other users. To access the forum, go to https://livebook.manning.com/book/tiny-c-projects/discussion. You can also learn more about Manning’s forums and the rules of conduct at https://livebook.manning.com/discussion.


  Manning’s commitment to our readers is to provide a venue where a meaningful dialogue between individual readers and between readers and the author can take place. It is not a commitment to any specific amount of participation on the part of the author, whose contribution to the forum remains voluntary (and unpaid). We suggest you try asking the author some challenging questions lest his interest stray! The forum and the archives of previous discussions will be accessible from the publisher’s website as long as the book is in print.


  
about the author
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  Dan Gookin has been writing about technology since the steam-powered days of computing. He combines his love of writing with his gizmo fascination to craft books that are informative and entertaining. Having written over 170 titles with millions of copies in print and translated into more than 30 languages, Dan can attest that his method of creating computer tomes seems to work.


  Perhaps his most famous title is the original DOS For Dummies, published in 1991. It became the world’s fastest-selling computer book, at one time moving more copies per week than the New York Times #1 best-seller list (though as a reference, it couldn’t be listed on the NYT best-seller list). From that book spawned the entire line of For Dummies books, which remains a publishing phenomenon to this day.


  Dan’s popular titles include PCs For Dummies, Android For Dummies, Word For Dummies, and Laptops For Dummies. His number-one programming title is C For Dummies, supported at c-for-dummies.com. Dan also does online training at LinkedIn Learning, where his many courses cover a diverse range of topics.


  Dan holds a degree in communications/visual arts from the University of California, San Diego. He resides in the Pacific Northwest, where he serves as councilman for the city of Coeur d’Alene, Idaho. Dan enjoys spending his leisure time gardening, biking, woodworking, and annoying people who think they’re important.


  
about the cover illustration


  The figure on the cover of Tiny C Projects is captioned “Femme de la Carniole,” or “Woman from Carniola,” taken from a collection by Jacques Grasset de Saint-Sauveur, published in 1797. Each illustration is finely drawn and colored by hand.


  In those days, it was easy to identify where people lived and what their trade or station in life was just by their dress. Manning celebrates the inventiveness and initiative of the computer business with book covers based on the rich diversity of regional culture centuries ago, brought back to life by pictures from collections such as this one.


  
1 Configuration and setup


  This first chapter is purely optional. If you already know how to build C code, especially if you’re familiar with working at the command prompt, stop wasting time and merrily skip up to chapter 2. Otherwise, slug it out and


  
    	
      Review the C language development cycle

    


    	
      Use an integrated development environment (IDE) to build code

    


    	
      Explore the excitement of command-line programming in a terminal window, just like Grandpa did

    


    	
      Review options for linking in libraries and supplying command-line arguments

    

  


  The purpose of this material is for review, though if you’ve never used a command line to program, you’re in for a treat: I find command-line programming to be fast and easy, specifically for the tiny programs created in this book. This code is well suited for the command-line environment.


  Still reading? Good. This chapter serves as a review when your C programming skills are rusty or if you just want to confirm that what you know is up to par for successfully navigating the rest of the book. I appreciate that you’re still here. Otherwise, these pages would be blank.


  And why do skills get rusty? Is it the iron and oxygen? The field of computer jargon needs to plant new terms for poor skills, something highly offensive and obnoxious to the point of being widely accepted. I’ll ruminate on the topic, and maybe add a quiz question along these lines at the end of the chapter.


  
1.1 The C development cycle


  According to ancient Mesopotamian tablets currently on display in the British Museum, four steps are taken to develop a C language program. These are illustrated in figure 1.1, where you can plainly see the C development cycle written in cuneiform.
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  Figure 1.1 The C development cycle, courtesy of the British Museum


  As a review, and because neither of us knows Babylonian, here is the translation:


  
    	
      Start by creating the source code file.

    


    	
      Compile the source code into object code.

    


    	
      Link in a library to create a program file.

    


    	
      Finally, run the program for testing, disappointment, or delight.

    

  


  Step 4 is a rather liberal translation on my part. The original reads, “Run the program and rejoice by consuming a cow.” I have also omitted references to pagan deities.


  These steps present a simple overview of the process. The steps are more numerous due to inevitable errors, bugs, booboos, and lack of cows. The following sections describe the details.


  
1.1.1 Editing source code


  C language source code is plain text. What makes the file a C source code file and not a boring ol’ text file is the .c filename extension; all C source code files use this filename extension. Eyeball code uses the .see extension. Naval code uses .sea. Know the difference.


  Use a text editor to craft your source code. Do not use a word processor, which is like using a helicopter to prune a tree. Don’t let the exciting visual image dissuade you; your goal is to use the best tool for the job. Any plain-text editor works, though the good ones offer features like color-coding, pattern matching, and other swanky features that make the process easier. I prefer the VIM text editor, which is available at vim.org. VIM is available as a both a text mode (terminal window) program and a GUI or windowed version.


  IDEs feature a built-in text editor, which is the point of the I in IDE: integrated. This editor is what you’re stuck with unless an option is available to change it. For example, in Visual Studio Code, you can obtain an extension to bring your favorite editor commands into the IDE.


  As a tip, the .c file extension defines a C language source code filetype, which is often associated by the operating system with your IDE. On my system, I associate .c files with my favorite VIM text editor. This trick allows me to double-click a C source code file icon and have it open in my text editor as opposed to having the IDE load.


  
1.1.2 Compiling, linking, building


  After writing the source code, you build the program. This process combines two original steps that only a handful of programmers at the Old Coder’s Home remember: compiling and linking. Most code babies today just think of compiling, but linking is still in there somewhere.


  After the source code file is as perfect as you can imagine, you compile it into object code: the compiler consumes the text in the source code file, churns through it, and spews forth an object code file. Object code files traditionally have a .o (“dot-oh”) filename extension unless your compiler or IDE opts for the heretical .obj extension.


  Items in your source code that offend the compiler are flagged as warnings or errors. An error terminates the process with an appropriately rude but helpful message. A warning may also thwart the creation of object code, but often the compiler shrugs its shoulders and creates an object code file anyway, figuring you’re smart enough to go back and fix the problem. You probably aren’t, which is why I admonish you to always take compiler warnings seriously.


  Object code is linked or combined with the C library file to build a program. Any errors halt the process, which must be addressed by re-editing the source code, compiling, and linking again.


  These days, the original separate steps of compiling and linking are combined into a single step called building. Compiling and linking still take place. No matter how many steps it takes, the result is the creation of a program.


  Run the program.


  I’m quite nervous when my efforts survive the building process with no warnings or errors. I’m even more suspicious when I run the program and it works properly the first time. Still, it happens. Prepare to be delighted or have your suspicions confirmed. When things go awry, which is most of the time, you re-edit the source code file, compile, link, and run again. In fact, the actual C program development cycle looks more like figure 1.2.
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  Figure 1.2 The true nature of the program development cycle. (Image courtesy of the California Department of Highway Safety.)


  For trivia’s sake, the original C compiler in Unix was called cc. Guess what it stands for?


  The original Unix linker was named ld. It probably stands for “link dis.” The ld program still exists on today’s Linux and other Unix-like systems. It’s called internally by the compiler—unless the code is riddled with errors, in which case the compiler calls its friend Betsy to giggle about how horrible your C code reads.


  Okay. The ld program most likely is short for Link eDitor. Please stop composing that email now.


  
1.2 The integrated development environment (IDE)


  Most coders prefer to work in an integrated development environment, or IDE—this program is software used to create software, like a toaster that makes toasters but also makes toast and bread.


  The IDE combines an editor, a compiler, and a running environment in a single program. Using an IDE is a must for creating GUI programs where you can build graphical elements like windows and dialog boxes and then add them to your code without the toil of coding everything by hand. Programmers love IDEs.


  
1.2.1 Choosing an IDE


  You don’t need an IDE to craft the programs presented in this course. I suggest that you use the command prompt, but you’re stubborn and love your IDE—and you’re still reading—so I’m compelled to write about it.


  The IDE I recommend for C programming is Visual Studio Code, available at code.visualstudio.com. It comes in Windows, macOS, and Linux flavors.


  Visual Studio Code can be overwhelming, so I also recommend Code::Blocks, available at codeblocks.org. Its best version is available only for Windows. Ensure that you obtain a version of Code::Blocks that comes with a compiler. The default is MinGW, which is nice. Better, get clang for Windows, which can be obtained at the LLVM website: llvm.org. You must manually cajole Code::Blocks into accepting clang as its compiler; details are offered in the next section.


  If you’re using Linux, you already have a compiler, gcc, which is the default. Even so, I recommend obtaining the LLVM clang compiler. It’s incredibly sophisticated. It features detailed error messages plus suggestions for fixing your code. If I were a robot, I would insist that clang be used to compile my brain’s software. Use your distro’s package manager to obtain this superb compiler at once!


  
1.2.2 Using Code::Blocks


  Though I prefer Visual Studio Code, I recommend Code::Blocks if you’re just starting out. Before you build your first program in the Code::Blocks IDE, confirm that the path to the compiler is correct. For a standard installation, the path is:

  C:\Program Files (x86)\CodeBlocks\MinGW\bin


  Ensure that this address is specified for Code::Blocks to locate the default compiler, MinGW, which I just mentioned. Or, if you’ve disobeyed the setup program’s suggestions, set the proper path to your compiler. For example, be spicy and use LLVM clang as your compiler. If so, set the proper path to that compiler so that Code::Blocks doesn’t barf every time you click the Build button.


  To set the path, heed these directions in Code::Blocks. Don’t be lazy! The missing compiler error message is one of the most common email complaint messages I receive from readers who can’t get Code::Blocks to work. Follow these steps in Code::Blocks:


  
    	
      Choose Settings > Compiler.

    


    	
      In the Compiler Settings dialog box, click the Toolchain Executables tab.

    


    	
      Write (or paste) the compiler’s address into the Compiler’s Installation Directory text box.

    


    	
      Click OK.

    

  


  The IDE should be happy with the compiler after you work through these steps. If not—yep, you guessed it—get some cows.


  Once the compiler is set, you use Code::Block’s built-in editor to create your code. The editor uses color-coding, matches parentheses and other pairs, and features inline context assistance for C library functions. All good.


  After creating—and saving—your source code, Code::Blocks uses a Build command to compile and link the source code. Messages are output in another part of the window where you read whether the operation succeeded or failed.


  Figure 1.3 shows the Code::Blocks workspace. Its presentation can be customized, though in the figure look for the callout items of the buttons used to build or run or do a combined build-and-run.


  [image: 01-03]



  Figure 1.3 Important stuff in the Code::Blocks IDE window


  Like all IDEs, Code::Blocks prefers that you create a new project when you start to code. The process works like this:


  
    	
      Click File > New > Project.

    


    	
      From the New From Template window, select the Console Application icon, and then click the Go button.

    


    	
      Select C as the programming language, and then click Next.

    


    	
      Type a title for the project, which is also the name of the project folder tree.

    


    	
      Choose the folder in which to create the project.

    


    	
      Click Next.

    


    	
      Select to create a Release configuration. You don’t need the Debug configuration unless you plan on using the Code::Blocks debugger (which is really quite cool, but no).

    


    	
      Click Finish to create the project skeleton.

    

  


  Code::Blocks spawns all kinds of folders and creates a prewritten source code file, main.c. You can replace the contents of this file with your own stuff. I find this entire process tedious, but it’s how an IDE prefers to work.


  As an alternative, you can use the File > New > Empty File command to open a new source code file in the editor. Immediately save the file with a .c filename extension to activate the editor’s nifty features. You can then proceed with creating an individual program without enduring the bulk and heft of a full-on project.


  Existing files—such as those you steal from GitHub for this book or for other, nefarious purposes—can be opened directly. The point of opening any file directly is that you don’t need the bulk and overhead of creating a project to create such small programs.


  To perform a quick compile and link in Code::Blocks, click the Build button. This step checks for warnings and errors but doesn’t run the created program. If things go well, click the Run button to view the output in a command prompt window, such as the one shown in figure 1.4.
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  Figure 1.4 The command prompt window


  Close the command prompt window when you’re done. Remember to do this! A common problem some people have with Code::Blocks is that they can’t see the output window. This dilemma most likely occurs because an output window is already open. Ensure that after test-running your programs, you close the wee li’l terminal window.


  If you’re feeling cocky, you can use the combo Build-and-Run button (refer to figure 1.3) instead of working through the separate Build and Run commands. When you click Build and Run, the code builds and immediately runs, unless you riddled the thing with errors, in which case you get to fix them.


  
1.2.3 Using XCode


  The XCode IDE on the Macintosh is a top-flight application used to build everything from macOS programs to those teensy apps that run on cell phones and wristwatches for the terminally hip. You can use this sophisticated tool to write the simple command-line, text mode utilities offered in this book. It’s kind of impractical, given the power of XCode, but this hindrance doesn’t prevent millions of Apple fans from doing so.


  If your Macintosh lacks XCode, you can obtain a copy for free from the App Store. If prompted, ensure that you choose to add the command-line tools.


  To create a text mode C language project in XCode, heed these directions:


  
    	
      Choose File > New > Project.

    


    	
      Select the Command Line Tool template for the project.

    


    	
      Click Next.

    


    	
      Type a name for the project.

    


    	
      Ensure that C is chosen as the language.

    


    	
      Click the Next button.

    


    	
      Confirm the folder location.

    


    	
      Click the Create button.

    

  


  XCode builds a project skeleton, providing the main.c file, complete with source code you can gleefully replace with your own.


  Alas, unlike with other IDEs, you cannot open an individual C source code file and then build and run it within XCode. This reason is why I recommend using command-line programming on the Mac, especially for the small, text mode utilities presented in this book. Refer to the next section.


  To build and run in XCode, click the Run icon, shown in figure 1.5. Output appears in the bottom part of the project window, as illustrated in the figure.
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  Figure 1.5 XCode’s window. (Squint to view clearly.)


  While the project files may dwell in the folder you chose earlier in step 7, the resulting program is created and buried deep within XCode’s folder system. This attempt at concealment makes it inconvenient for running and testing command-line programs demonstrated in this book. Specifically, to set command-line options or perform I/O redirection at the prompt requires jumping through too many hoops. To me, this awkwardness makes using XCode as your IDE an option limited to masochists and the fanatical Apple type.


  
1.3 Command-line compiling


  Welcome to the early years of computing. It’s nostalgic to edit, build, and run C programs in text mode, but it works well and is quite efficient. You must understand how the command line works, which is something I believe all C programmers should know innately. Truly, it’s rare to find a C coder worthy of the title who lacks a knowledge of text mode programming in Unix or Linux.


  
1.3.1 Accessing the terminal window


  Every Linux distro comes with a terminal window. MacOS features a terminal program. Even Windows 10 comes with a command shell, though it’s better to install the Windows Subsystem for Linux (WSL) and use an Ubuntu bash shell for consistency with the other platforms. Never have the times been so good for text mode programming. Crack open a Tab and kick off your sandals!


  
    	
      To start a terminal window in Linux, look for the Terminal program on the GUI’s program menu. It may be called Terminal, Term, Xterm, or something similar.

    


    	
      On the Mac, start the Terminal application, which is found in the Utilities folder. Access this folder from the Finder by clicking Go > Utilities from the menu or by pressing the Shift+Command+U keyboard shortcut.

    


    	
      In Windows 10, open the Microsoft Store and search for the Ubuntu app. It’s free to download, but to make it work you must also install the WSL. Directions for installing the subsystem are splattered all over the Internet.

    

  


  The Windows 10 Ubuntu app is shown in figure 1.6. Like all other terminal windows, it can be customized: you can reset the font size, the number of rows and columns, screen colors, and so on. Be aware that the traditional text mode screen supported 80 columns by 24 rows of text.
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  Figure 1.6 Linux in Windows—such sacrilege


  If you plan on using the terminal window for your program production, I recommend keeping a shortcut to the Terminal program available for quick access. For example, in Windows, I pin a shortcut to the Ubuntu shell on the taskbar. On the Mac, I have my Terminal window automatically start each time I sign into OS X. Directions for accomplishing such tasks are concealed on the internet.


  
1.3.2 Reviewing basic shell commands


  I bet you know a few shell commands. Good. In case doubt lingers, table 1.1 lists some commands you should be familiar with to make it easy to work at the command prompt. These are presented without context or further information, which helps maintain the command prompt’s mysterious and powerful aura.


  Table 1.1 Shell commands worthy of attention


  
    
      
      
    

    
      	
        Command

      

      	
        What it does

      
    


    
      	
        cd

      

      	
        Change to the named directory. When typed without an argument, the command changes to your home directory.

      
    


    
      	
        cp

      

      	
        Copy a file.

      
    


    
      	
        exit

      

      	
        Log out of the terminal window, which may close the window.

      
    


    
      	
        ls

      

      	
        List files in the current directory.

      
    


    
      	
        man

      

      	
        Summon the manual page (online documentation) for the named shell command or C language function. This is the most useful command to know.

      
    


    
      	
        mkdir

      

      	
        Make a new directory.

      
    


    
      	
        mv

      

      	
        Move a file from one directory to another. Also used to rename a file.

      
    


    
      	
        pwd

      

      	
        Print the current working directory.

      
    


    
      	
        unlink

      

      	
        Delete the named file.

      
    

  


  Each of the commands listed in table 1.1 has options and arguments, such as filenames and pathnames. Most everything is typed in lowercase and spelling errors unforgivable. (Some shells offer spell-check and command completion.)


  Another command to know is make, which helps build larger projects. This command is covered later in this book. I’d list a chapter reference, but I haven’t written the chapter yet.


  Also important is to know how the package manager works, though with many Linux distros you can obtain command-line packages from the GUI package manager. If not, familiarize yourself with how the command-line package manager works.


  For example, in Ubuntu Linux, use the apt command to search for, install, update, and remove command-line software. Various magical options make these things happen. Oh, and the apt command must be run from the superuser account; onscreen directions explain the details.


  My final recommendation is to understand the file-naming conventions. Spaces and other oddball characters are easy to type in a GUI, but at the command prompt, they can be nettlesome. For the most part, prefix spaces with the backslash character, \ , which acts as an escape. You can also take advantage of filename completion: in bash, zsh, and other shells, type the first part of a filename, and then press the Tab key to spew out the rest of the name automatically.


  File-naming conventions also cover pathnames. Understand the difference between relative and absolute paths, which helps when running programs and managing your files.


  I’m sure you can find a good book somewhere to help you brush up on your Linux knowledge. Here is an obligatory plug for a tome from Manning Publications: Learn Linux in a Month of Lunches, by Steven Ovadia (2016). Remember, it’s free at the library.


  
1.3.3 Exploring text screen editors


  To properly woo the command prompt, you must know how to use a text mode editor. Many are installed by default with Linux. Those that aren’t can be obtained from your distro’s package manager. On the Mac, you can use the Homebrew system to add text mode programs that Apple deems unworthy to ship with its operating system; learn more about Homebrew at brew.sh.


  My favorite text mode editor is VIM, the improved version of the classic vi editor. It has a terminal window version that runs in text mode as well as a full GUI version. The program is available for all operating systems.


  The thing that ticks off most coders about VIM is that it’s a modal editor, which means you must switch between text editing and input modes. This duality drives some programmers crazy, which is fine by me.


  Another popular text mode editor is Emacs. Like VIM, it’s also available as a text mode editor as well as a GUI editor. I don’t use Emacs, so I am unable to wax eloquent upon its virtues.


  Whatever text editor you obtain, ensure that it offers C language color-coding as well as other helpful features like matching pairs: parentheses, brackets, and braces. With many editors, it’s possible to customize features, such as writing a startup script that properly contorts the editor to your liking. For example, I prefer a four-space tab stop in my code, which I can set by configuring the .vimrc file in my home directory.


  
1.3.4 Using a GUI editor


  It may be scandalous, but it’s convenient to use a GUI editor while you work at the command prompt. This arrangement is my preferred programming mode: I write code in my editor’s glorious graphical window and then build and run in the dreary text mode terminal window. This arrangement gives me the power of a GUI editor and the ability to examine text mode output at the same time, as illustrated in figure 1.7.
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  Figure 1.7 A desktop with an editor and a terminal window arranged just so


  The only limitation to using a GUI editor is that you must remember to save the source code in one window before you build in the other. This reminder isn’t as much of an issue when you use a text mode editor running in the terminal, because you save when you quit. But when bouncing between two different windows on a desktop, it’s easy to forget to save.


  
1.3.5 Compiling and running


  The command-line compiler in Linux is gcc, which is the GNU version of the original cc compiler from the caveman days of Unix. As I wrote earlier, I recommend using the clang compiler instead of gcc. It offers better error reporting and suggestions. Use your distro’s package manager to obtain clang or visit llvm.org. For the remainder of this chapter, as well as the rest of this book, my assumption is that you use clang as your compiler.


  To build code, which includes both the compiling and linking steps, use the following command:

  clang -Wall source.c


  The compiler is named clang. The -Wall switch activates all warnings—always a good idea. And source.c represents the source code filename. The command I just listed generates a program file, a.out, upon success. Warnings may also yield a program file; run it at your own peril. Error messages indicate a serious problem you must address; no program file is generated.


  If you desire to set an output filename, use the -o switch followed by the output filename:

  clang -Wall source.c -o program


  Upon success, the previous command generates a program file named program.


  The compiler sets the program’s executable bit as well as file permissions that match those for your account. Once your program is created, it’s ready to run.


  To run the program, you must specify its full pathname. Remember that in Linux, unless the program exists in a directory on the search path, a full pathname must be specified. For programs in the current directory, use the ./ prefix, like so:

  ./a.out


  This command runs the program file a.out, located in the current directory, as shown here:

  ./cypher


  This command runs the program name cypher, again located in the current directory.


  The single dot is an abbreviation for the current directory. The slash separates the pathname from the filename. Together, the ./ forces the shell to locate and run the named program in the current directory. Because the program’s executable bit is set, its binary data is loaded into memory and executed.


  
1.4 Libraries and compiler options


  As someone who aspires to improve the craft, you must be aware of the assortment of compiler options—specifically, those that link in libraries. These libraries expand a mere mortal C program into realms of greater capabilities.


  All C programs link in the standard C library. This library contains the horsepower behind such functions as printf(). Yet, it’s a common misconception among beginning C programmers that it’s the header file that contains the oomph. Nope. The linker builds the program by combining object code (created by the compiler) with a C language library.


  Other libraries are also available, which are linked in addition to the standard C library to build complex and interesting programs. These libraries add more capabilities to your program, providing access to the internet, graphics, specific hardware, and a host of other useful features. Hundreds of libraries are available, each of which helps extend your program’s potential. The key to using these libraries is to understand how they’re linked in, which also raises the issue of compiler options or command-line switches.


  As you may expect, methods of adding options and linking libraries differ between the IDE and command prompt approaches to creating programs.


  
1.4.1 Linking libraries and setting other options in an IDE


  One area where using an IDE becomes inconvenient is the task of setting compiler options or specifying command-line arguments. Setting the options includes linking in a library. You must not only discover where the linking option is hidden but also confirm the location of the library on the filesystem and ensure that it’s compatible with the compiler.


  I don’t have the time, and it’s really not this book’s subject, to get into specifics for each IDE and how they set command-line arguments for the programs you build or how specific options are set, such as linking in an extra compiler. After all, I push command-line programming enough—get the hint! But if you insist, or you just enjoy seeing how difficult things can be, read on. For brevity’s sake, I’ll stick with Code::Blocks because I know it best. Other IDEs have similar options and settings. I hope.


  Compiler options in Code::Blocks are found in the Settings dialog box: click Settings > Compiler to view the dialog box, shown in figure 1.8. This is the same location where you specify another library to link.
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  Figure 1.8 Finding useful stuff in the Code::Blocks’ Settings dialog box


  Preset options are listed on the Compiler Flags tab, illustrated in figure 1.8. This tab is a subtab of the Compiler Settings tab, also called out in the figure. The command-line switches for each option are shown at the end of the descriptive text.


  Use the Other Compiler Options tab to specify any options not found on the Compiler Flags tab. I can’t think of any specific options you might consider adding, but this tab is where they go.


  Click the Linker Settings tab (refer to figure 1.8) to add libraries. Click the Add button to browse for a library to link in. You must know the folder in which the library file dwells. Unlike command-line compiling, default directories for library files aren’t searched automatically. Ditto for header files, which are often included in the same directory tree as the libraries.


  To specify command-line arguments for your programs in Code::Blocks, use the Project > Set Programs’ Arguments command. The problem here is that the apostrophe is misplaced on the menu; it should read Program’s. I mention this because my editor will query me otherwise.


  After choosing the grammatically incorrect Set Programs’ Arguments command, you see the Select Target dialog box. Use the Program Arguments text field to specify required arguments for the programs you run in the IDE. The limitation here is that your command-line program must be built as a project in Code::Blocks. Otherwise, the option to set command-line arguments is unavailable.


  Please be aware that the tiny programs presented in this book are designed to run at the command prompt, which makes it weird to set arguments in an IDE. Because the IDE creates a program, you can always navigate to the program folder to run the program directly at a command prompt. If possible, discover whether your IDE allows you quick access to the folder containing the program executable. Or just surrender to the inevitable ease and self-fulfilling joy of programming in a terminal window.


  
1.4.2 Using command-line compiler options


  It’s easy and obvious to type compiler options and program arguments at a command prompt in a terminal window: no extra settings, menus, mouse clicks, or other options to hunt for. Again, these are many of the reasons programming at the command prompt makes sense for the programs presented in this book, as well as for lots of tiny C projects.


  Of the slate of command-line options, one worthy of note is -l (little L). This switch is used to link in a library. The -l is followed immediately by the library name, as in:

  clang -Wall weather.c -lcurl


  Here, the libcurl library, named curl, is linked along with the standard C library to build a program based on the weather.c source code file. (You don’t need to specify the standard C library, because it’s linked in by default.)


  To specify an output filename, use the -o switch as covered earlier in this chapter:

  clang -Wall weather.c -lcurl -o weather


  With some compilers, option order is relevant. If you see a slew of linker errors when using the -l switch, change the argument order to specify -l last:

  clang -Wall weather.c -o weather -lcurl


  At the command line, the compiler searches default directories for locations of library files as well as header files. In Unix and Linux—but not OS/X—these locations follow:


  
    	
      Header files: /usr/include

    


    	
      Library files: /usr/lib

    

  


  Custom library and header files you install can be found at these locations:


  
    	
      Header files: /usr/local/include

    


    	
      Library files: /usr/local/lib

    

  


  The compiler automatically searches these directories for header files and libraries. If the library file exists elsewhere, you specify its pathname after the -l switch.


  No toil is involved in specifying command-line arguments for your programs. Unlike an IDE, the arguments are typed directly after the program name:

  ./weather KSEA


  Here, the weather program runs in the current directory with a single argument, KSEA. Simple. Easy. I shan’t use further superlatives.


  
1.5 Quiz


  I decided against adding a quiz.


  
2 Daily greetings


  Your computer day starts when you sign in. The original term was log in, but because trees are so scarce and signs are so plentiful, the term was changed by the Bush administration in 2007. Regardless of such obnoxious federal overreach, your computer day can start with a cheerful greeting after you sign in or open a terminal window, customized by a tiny C program. To make it so, you will:


  
    	
      Review the Linux startup process.

    


    	
      Discover where in the shell script to add your greeting.

    


    	
      Write a simple greetings program.

    


    	
      Modify your greetings program to add the time of day.

    


    	
      Update the timestamp with the current moon phase.

    


    	
      Enhance your greetings message with a bon mot.

    

  


  The programs created and expanded upon in this chapter are specific to Linux, macOS, and the Windows Subsystem for Linux (WSL), where a startup script is available for configuring the terminal window. A later section explains which startup scripts are available for the more popular shells. This chapter doesn’t go into creating a daily greeting message when the GUI shell starts.


  I suppose you could add a startup message for the Windows terminal screen, the command prompt. It’s possible, but the process bores me, and only hardcore Windows nerds would care, so I’m skipping the specifics. The greetings programs still run at the Windows command prompt, if that’s your desire. Otherwise, you may lodge your complaints with me personally; my email address is found in this book’s introduction. I promise not to answer a single email from a whiny Windows user.


  
2.1 The shell starts


  Linux has a long, involved, and thoroughly exciting boot process. I’m certain that you’re eager to read all the nitty-gritty details. But this book is about C programming. You must seek out a Linux book to know the complete, torrid steps involved with rousing a Linux computer. The exciting stuff relevant to creating a daily greeting happens later, after the operating system completes its morning routine, when the shell starts.


  
2.1.1 Understanding how the shell fits in


  Each user account on a Linux system is assigned a default shell. This shell was once the only interface for Linux. I recall booting into an early version of Red Hat Linux back in the 1990s and the first—and only—thing I saw was a text mode screen. Today things are graphical, and the shell has been shunted off to a terminal window. It’s still relevant at this location, which is great for C programming.


  The default shell is configured by the something-or-other. I’m too lazy to write about it here. Again, this isn’t a Linux book. Suffice it to say that your account most likely uses the bash shell—a collision of the words “Bourne again shell,” so my writing “bash shell” is redundant (like ATM machine), but it looks awkward otherwise.


  To determine the default shell, start a terminal window. At the prompt, type the command echo $SHELL:

  $ echo $SHELL
/bin/bash


  Here, the output confirms that the assigned user shell is bash. The $SHELL argument represents the environment variable assigned to the startup shell, which is /bin/bash here. This output may not reflect the current shell—for example, if you’ve subsequently run the sh or zsh or similar command to start another shell.


  To determine the current shell, type the command ps -p $$:

  $ ps -p $$
  PID TTY          TIME CMD
    7 tty1     00:00:00 bash


  This output shows the shell command is bash, meaning the current shell is bash regardless of the $SHELL variable’s assignment.


  To change the shell, use the chsh command. The command is followed by the new shell name. Changing the shell affects only your account and applies to any new terminal windows you open after issuing the command. That’s enough Linux for today.


  
2.1.2 Exploring various shell startup scripts


  When a shell starts, it processes commands located in various startup scripts. Some of these scripts may be global, located in system directories. Others are specific to your account, located locally in your home folder.


  Startup scripts configure the terminal. They allow you to customize the horrid text-only experience, perhaps adding colors, creating shortcuts, and performing various tasks you may otherwise have to manually perform each time a terminal window opens. Any startup script file located in your home directory is yours to configure.


  Given all that, the general advice is not to mess with startup shell scripts. To drive home this point, the shell script files are hidden in your home directory. The filenames are prefixed with a single dot. The dot prefix hides files from appearing in a standard directory listing. This stealth allows the files to be handy yet concealed from a casual user’s attempts to meddle with them.


  Because you want to meddle with the shell startup script, specifically to add a personalized greeting, it’s necessary to know the script names. These names can differ, depending upon the shell, though the preferred startup script to edit appears in table 2.1.


  Table 2.1 Tediously dry info regarding Linux shell scripts


  
    
      
      
      
      
    

    
      	
        Shell

      

      	
        Name

      

      	
        Command

      

      	
        Startup filename

      
    


    
      	
        Bash

      

      	
        Bash, “Bourne again shell”

      

      	
        /bin/bash

      

      	
        .bash_profile

      
    


    
      	
        Tsch

      

      	
        Tee C shell

      

      	
        /bin/tsch

      

      	
        .tcshrc

      
    


    
      	
        Csh

      

      	
        C shell

      

      	
        /bin/csh

      

      	
        .cshrc

      
    


    
      	
        Ksh

      

      	
        Korn shell

      

      	
        /bin/ksh

      

      	
        .profile

      
    


    
      	
        Sh

      

      	
        Bourne shell

      

      	
        /bin/sh

      

      	
        .profile

      
    


    
      	
        Zsh

      

      	
        Z shell

      

      	
        /bin/zsh

      

      	
        .zshrc

      
    

  


  For example, for the bash shell, I recommend editing the startup script .bash_profile to add your greeting. Other startup scripts may run when the shell starts, but this is the script you can modify.


  To view your shell’s startup script, use the cat command in a terminal window. Follow the command with the shell’s startup filename. For example:

  $ cat ~/.bash_profile


  The ~/ pathname is a shortcut for your home directory. After you issue the preceding command, the contents of the shell startup script vomit all over the text screen. If not, the file may not exist and you need to create it.


  When you see the file’s contents, somewhere in the morass you can stick your greetings program on a line by itself. The rest of the script shouldn’t be meddled with—unless you’re adept at coding in the scripting language and crafting brilliant startup scripts, which you probably aren’t.


  
2.1.3 Editing the shell startup script


  Shell startup scripts are plain text files. They consist of shell commands, program names, and various directives, which makes the script work like a programming language. The script is edited like any text file.


  I could wax eloquent for several pages about shell scripting, but I have a dental appointment in an hour and this book is about C programming. Still, you should note two relevant aspects of a startup shell script: the very first line and the file’s permissions.


  To interpret the lines of text in a startup script, the very first line of the file directs the shell to use a specific program to process the remaining lines in the file. Traditionally, the first line of a Unix shell script is:

  #!/bin/sh


  This line starts with the #, which makes it a comment. The exclamation point, which the cool kids tell me is pronounced “bang,” directs the shell to use the /bin/sh program (the original Bourne shell) to process the remaining lines of text in the file. The command could be anything, from a shell like bash to a utility like expect.


  All shell scripts have their executable permissions bit set. If the file exists, this setting is already made. Otherwise, if you’re creating the shell script, you must bless it with the executable bit after the file is created. Use the chmod command with the +x switch, followed by the script filename:

  chmod +x .bash_profile


  Issuing this command is required only when you initially create the script.


  Within the startup script, my recommendation is to set your greetings program on a line by itself at the end of the script. You can even prefix it with a comment, starting the line before with the # character. The cool kids have informed me that # is pronounced “hash.”


  For practice, edit the terminal window’s startup script: open a terminal window and use your favorite text editor to open the shell’s startup script, as noted in table 2.1. For example, on my Linux system, I type:

  vim ~/.bash_profile


  Add the following two lines at the bottom of the script, after all the stuff that looks impressive and tempting:

  # startup greetings
echo "Hello" $LOGNAME


  The first line is prefixed with a #. (I hope you said “hash” in your head.) This tag marks the line as a comment.


  The second line outputs the text "Hello" followed by the contents of environment variable $LOGNAME. This variable represents your login account name.


  Here’s sample output:

  Hello dang


  My account login is dang, as shown. This line of text is the final output generated by the shell startup script when the terminal window first opens. The C programs generated for the remainder of this chapter replace this line, outputting their cheerful and interesting messages.


  When adding your greetings program to the startup script, it’s important that you specify its pathname, lest the shell script interpreter freak out. The path can be full, as in:

  /home/dang/cprog/greetings


  Or it can use the ~/ home directory shortcut:

  ~/cprog/greetings


  In both cases, the program is named greetings, and it dwells in the cprog directory.


  
2.2 A simple greeting


  All major programming projects start out simple and have a tendency to grow into complex, ugly monsters. I’m certain that Excel began its existence as a quick-and-dirty, text mode calculator—and now look at it. Regardless, it’s good programming practice not to begin a project by coding everything you need all at once. No, it’s best to grow the project, starting with something simple and stupid, which is the point of this section.


  
2.2.1 Coding a greeting


  The most basic greetings program you can make is a simple regurgitation of the silly Hello World program that ushers in the pages of every introductory C programming book since Moses. Listing 2.1 shows the version you could write for your greetings program.


  Listing 2.1 Source code for greet01.c

  #include <stdio.h>
 
int main()
{
    printf("Hello, Dan!\n");
 
    return(0);
}


  Don’t build. Don’t run. If you do, use this command to build a program named greetings:

  clang -Wall greet01.c -o greetings


  You may substitute clang with your favorite-yet-inferior compiler. Upon success, the resulting program is named greetings. Set this program into your shell’s startup script, adding the last line that looks like this:

  greetings


  Ensure that you prefix the program name with a pathname—either the full pathname, like this:

  /home/dang/bin/greetings


  or a relative pathname:

  ~/bin/greetings


  The startup script cannot magically locate program files, unless you specify a path, such as my personal ~/bin directory shown in the examples. (I also use my shell startup script to place my personal ~/bin directory on the search path—another Linux trick found in another book somewhere.)


  After the startup script is updated, the next terminal window you open runs a startup script that outputs the following line, making your day more cheerful:

  Hello, Dan!


  And if your name isn’t Dan, then the greeting is more puzzling than cheerful.


  
2.2.2 Adding a name as an argument


  The initial version of the greetings program is inflexible. That’s probably why you didn’t code it and are instead eager to modify it with some customization.


  Consider the modest improvement offered in listing 2.2. This update to the code allows you to present the program with an argument, allowing it to be flexible.


  Listing 2.2 Source code for greet02.c

  #include <stdio.h>
 
int main(int argc, char *argv[])
{
    if( argc<2)                              ❶
        puts("Hello, you handsome beast!");
    else
        printf("Hello, %s!\n",argv[1]);      ❷
 
    return(0);
}


  ❶ The argument count is always 1 for the program name; if so, a default message is output.


  ❷ The first word typed after the program name is represented as argv[1] and is output here.


  Build this code into a program and thrust it into your shell’s startup script as written in the ancient scrolls but also in the preceding section:

  greetings Danny


  The program now outputs the following message when you open a new terminal window:

  Hello, Danny!


  This new message is far more cheerful than the original but still begging for some improvement.


  
2.3 The time of day


  One of the first programs I wrote for my old DOS computer greeted me every time I turned on the computer. The program was similar to those created in the last two sections, which means it was boring. To spice it up, and inspired by my verbal interactions with humans I encounter in real life, I added code to make the greeting reflect the time of day. You can do so as well with varying degrees of accuracy.


  
2.3.1 Obtaining the current time


  Does anyone really know what time it is? The computer can guess. It keeps semi-accurate time because it touches base with an internet time server every so often. Otherwise, the computer’s clock would be off by several minutes every day. Trust me, computers make lousy clocks, but this truth doesn’t stop you from plucking the current time from its innards.


  The C library is rife with time functions, all defined in the time.h header file. The time_t data type is also defined in the header. This positive integer value (long data type, printf() placeholder %ld) stores the Unix epoch, the number of seconds ticking away since midnight January 1, 1970.


  The Unix epoch is a great value to use in your greetings program. For example, imagine your joy at seeing—every day when you start the terminal—the following jolly message:

  Hello, Danny, it's 1624424373


  Try to hold back any emotion.


  Of course, the time_t value must be manipulated into something a bit more useful. Listing 2.3 shows some sample code. Be aware that many time functions, such as time() and ctime() used in the code for time01.c, require the address of the time_t variable. Yup, they’re pointers.


  Listing 2.3 Source code for time01.c

  #include <stdio.h>
#include <time.h>                                   ❶
 
int main()
{
    time_t now;
 
    time(&now);                                     ❷
    printf("The computer thinks it's %ld\n",now);
    printf("%s",ctime(&now));                       ❸
 
    return(0);
}


  ❶ The time.h header file is required, lest the compiler become cross with you.


  ❷ The time() function requires the time_t variable’s address, prefixed here with the & address-of operator.


  ❸ The ctime() function requires a pointer argument and returns a string appended with a newline.


  Here is sample output from the resulting program:

  The computer thinks it's 1624424373
Tue Jun 22 21:59:33 2021


  The output shows the number of seconds of tick-tocking since 1970. This same value is swallowed by the ctime() function to output a formatted time string. This result may be acceptable in your greetings program, but time data can be customized further. The key to unlocking specific time details is found in the localtime() function, as the code in listing 2.4 demonstrates.


  Listing 2.4 Source code for time02.c

  #include <stdio.h>
#include <time.h>
 
int main()
{
    time_t now;
    struct tm *clock;                                         ❶
 
    time(&now);
    clock = localtime(&now);
    puts("Time details:");
    printf(" Day of the year: %d\n",clock->tm_yday);
    printf(" Day of the week: %d\n",clock->tm_wday);          ❷
    printf("            Year: %d\n",clock->tm_year+1900);     ❸
    printf("           Month: %d\n",clock->tm_mon+1);         ❹
    printf("Day of the month: %d\n",clock->tm_mday);
    printf("            Hour: %d\n",clock->tm_hour);
    printf("          Minute: %d\n",clock->tm_min);
    printf("          Second: %d\n",clock->tm_sec);
 
    return(0);
}


  ❶ Because localtime() returns a pointer, it’s best to declare the structure as a pointer.


  ❷ The first day of the week is 0 for Sunday.


  ❸ You must add 1900 to the tm_year member to get the current year; you will forget this.


  ❹ The tm_mon member ranges from 0 to 11.


  I formatted the code in listing 2.4 with oodles of spaces so that you could easily identify the tm structure’s members. These variables represent the time tidbits that the localtime() function extracts from a time_t value. Ensure that you remember to adjust some values as shown in listing 2.4: the year value tm_year must be increased by 1900 to reflect the current, valid year; the month value tm_mon starts with zero, not one.


  The output is trivial, so I need not show it—unless you send me a check for $5. Still, the point of the code is to show how you can obtain useful time information with which to properly pepper your terminal greetings.


  
2.3.2 Mixing in the general time of day


  The program I wrote years ago for my DOS computer was called GREET.COM. It was part of my computer’s AUTOEXEC.BAT program, which ran each time I started my trusty ol’ IBM PC. Because I’m fond of nostalgia, I’ve kept a copy of the program. Written in x86 Assembly, it still runs under DOSBox. Ah, the sweet perfume of the digital past. Smells like ozone.


  Alas, I no longer have the source code for my GREET.COM program. From memory (and disassembly), I see that the code fetches the current hour of the day and outputs an appropriate time-of-day greeting: good morning, good afternoon, or good evening. You can code the same trick—though in C for your current computer and not in x86 Assembly for an ancient IBM PC.


  Pulling together resources from the first chunk of this chapter, listing 2.5 shows a current version of my old greetings program.


  Listing 2.5 Source code for greet03.c

  #include <stdio.h>
#include <time.h>
 
int main(int argc, char *argv[])
{
    time_t now;
    struct tm *clock;
    int hour;
 
    time(&now);
    clock = localtime(&now);
    hour = clock->tm_hour;     ❶
 
    printf("Good ");
    if( hour < 12 )            ❷
        printf("morning");
    else if( hour < 17 )       ❸
        printf("afternoon");
    else                       ❹
        printf("evening");
 
    if( argc>1 )               ❺
        printf(", %s",argv[1]);
 
    putchar('\n');
 
    return(0);
}


  ❶ This statement is a convenience to avoid using clock->tm_hour over and over.


  ❷ Before noon, say “Good morning.”


  ❸ From noon to 5:00 P.M., say “Good afternoon.”


  ❹ Otherwise, it’s evening.


  ❺ Check for and output the first command-line argument.


  Assuming that the built program is named greetings, that the user types in Danny as the command-line argument, and that it’s 4 o’clock in the afternoon, here is the code’s output:

  Good afternoon, Danny


  This code effectively replicates what I wrote decades ago as my GREET.COM program. The output is a cheery, time-relevant greeting given the current time of day.


  For extra humor, you can add a test for early hours, such as midnight to 4:00 AM. Output some whimsical text such as “Working late?” or “Are you still up?” Oh, the jocularity! I hope your sides don’t hurt.


  
2.3.3 Adding specific time info


  Another way to treat yourself when you open a terminal window is to output a detailed time string. The simple way to accomplish this task is to output the greeting followed by a time string generated by the ctime() function. Here are the two relevant lines of code:

  printf(“Good day, %s\n”,argv[1]);
printf(“It’s %s”,ctime(&now));


  These two statements reflect code presented earlier in this chapter, so you get the idea. Still, the program is lazy. Better to incorporate the strftime() function, which formats a timestamp string according to your specifications.


  The strftime() function works like printf(), with a special string that formats time information. The function’s output is saved in a buffer, which your code can use later. The code shown in listing 2.6 demonstrates.


  Listing 2.6 Source code for greet04.c

  #include <stdio.h>
#include <time.h>
 
int main(int argc, char *argv[])
{
    time_t now;
    struct tm *clock;
    char time_string[64];        ❶
 
    time(&now);
    clock = localtime(&now);     ❷
 
    strftime(time_string,64,"Today is %A, %B %d, %Y%nIt is %r%n",clock);
 
    printf("Greetings");
    if( argc>1 )
        printf(", %s",argv[1]);
    printf("!\n%s",time_string);
 
    return(0);
}


  ❶ Storage for the string filled by the strftime() function


  ❷ You must fill a localtime() tm structure to make the strftime() function work.


  You can review the man page for strftime() to discover all the fun placeholders and what they do. Like the printf() function, the placeholders are prefixed by a % character. Any other text in the formatting string is output as is. Here are the highlights from the strftime() statement in listing 2.6:


  [image: 02-00_UN01]



  The output reflects the time string generated and stored in the time_string[] buffer. The time string appears after the general greeting as covered earlier in this chapter:

  Greetings, Danny!
Today is Wednesday, June 23, 2021
It is 04:24:47 PM


  At this point, some neckbeard might say that all this output can easily be accomplished by using a shell scripting language, which is the native tongue of the shell startup and configuration file anyway. Yes, such people exist. Still, as a C programmer, your job is to offer more insight and power to the greeting. Such additions aren’t possible when using a sad little shell scripting language. So there.


  
2.4 The current moon phase


  My sense is that most programmers operate best at night. So why bother programming a moon phase greeting when you can just pop your head out a window and look up?


  You’re correct: the effort is too much trouble, especially when you can write a C program to get a good approximation of the moon phase while remaining safely indoors. You can even delight yourself with this interesting tidbit every time you start a terminal window. Outside? It’s overrated.


  
2.4.1 Observing moon phases


  The ancient Mayans wrote the first moon phase algorithm, probably in COBOL. I’d print a copy of the code here, but it’s just easier to express the pictogram: it’s a little guy squatting on a rock, extending a long tongue, wearing a festive hat, and wearing an angry expression on his face. Programmers know this stance well.
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